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Introduction - Exsion Reporting for Business Central Online 

  

Exsion Reporting BC is an Excel add-in, especially developed to quickly and easily present figures from 

Dynamics BC administrations (in real time). By combining Excel functionality and presentation power 

with a real-time connection to reliable figures from your administration, you can retrieve concise reports  

with respect to various companies and/or time periods. 

 

With Exsion Reporting BC, you are no longer dependent on the static reporting formats of Dynamics BC. You 

can decide yourself how reports are structured, in a presentation format that you define. The use of colours 

and diagrams significantly increases the presentation value 

Overviews in a specific format, that have already been created in Excel, in which data must be entered or 

copied into for each given period, can easily be converted to Exsion Reporting BC overviews.  

 

In short: Exsion Reporting BC offers time savings, information and ease of use without additional processes, 

from a variety of accounts and even different databases. 

 

Note: This manual uses the Cronus demonstration database, but you can execute commands on your own 

database.  

 

This manual is structured as follows: 

 

Chapter 2 provides a clear overview of the Exsion Reporting BC menu; 

Chapter 3 deals with downloads; 

Chapter 4 provides an overview of the use of pivot tables. 
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Chapter 2 - Exsion Reporting BC Menu 

 
When Exsion Reporting BC is installed, your Excel menu ribbon will be extended with the Exsion Reporting BC 

menu.  

The extended menu is activated by a single click on the Exsion Reporting BC-menu, which will result in the 

menu listed below: 

 

 
 

This chapter does not deal with Downloads, these will be treated in the next chapter. 

 

Connection 

 
The use of Exsion Reporting BC requires (a) defined connection(s). A connection is a link to a company  

(or administration) within a database. You have to define a connection for each company.  

Exsion Reporting BC will store defined connections. 

Click Connection in the Exsion Reporting BC menu. 

 

 

 

You will be taken to the following screen: 
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In this screen, you will enter the URL and select the type: Access key or Windows. The access key type will allow 

you to login with your username and the webservice access key code. 

 

When you have entered them correctly, you can proceed the final step, selecting the language code. 

Refreshing Data 

 

 
 
The Refresh data command allows you update data within a report. Let’s assume, that you have developed a 

report that shows actual stock levels. If one of your colleagues were to make stock changes, you will no longer 

have an overview of the current state of affairs. If you click <Refresh data>, actual data will be retrieved and 

placed in the worksheet. 

Help  

 

 

The Help tool provides a description of the complete functionality of Exsion Reporting BC, and therefore also 

functions as the manual. You can print it by clicking <Print> in the Help window. 
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Info 

 

 

 

The Options window provides information about: 

• Settings: See the explanation below 

• Support: The possibility to start a TeamViewer session for helpdesk support  

• Version: Exsion Reporting BC version (current installed version) 

• Licence: Licences in use 

 

 

 

Here you can select the interface language of Exsion Reporting BC. 
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Chapter 3 - Downloads  

In the previous chapter, customer numbers and general ledger account numbers were entered manually each 

time. However, when reports increase in size, manual data entry is no longer efficient. This process can be 

replaced by a data download. A download always consists of a download definition and the output (i.e. the 

result). Any changes affecting the output should therefore always be stated in the definition. 

 
Dynamic Download Wizard 

Click the <Dynamic download> button to create a new download. 

 

 
 

You will be taken to the screen below: 
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1 Add Lists the tables you can choose from (dependent on the selected 

connection). 

2 Search Type the table name (or a part thereof) or the table number to perform a 

fast search. 

3 Selection 

buttons 

Use the >> button to select all fields. Clicking the > button will select a 

single field.  Use the < and << buttons to deselect a single field or all 

fields, respectively.  

4 Fields The Fields tab will list all fields selected for the download.  

5 Method Use this pull-down menu for, for example, an aggregate presentation of 

download output, or to retrieve the first or last value from a table. 

 

Tip: Storing download definitions 

When you have created a download definition, you can store it by clicking the <Save> button. The definition 

will be stored in an .edd file, which can be imported easily. 

 

Defining Downloads 

As stated previously in this chapter, a download consists of two parts. Prior to retrieving data from the system 

(which also applies to Extensions), you first have to specify which data you want to retrieve (i.e. creating the 

download definition). 

 

Open the download wizard by clicking the <Dynamic download> button. You will be taken to the screen 

below: 

 

 

Double-click on the Customer table (no. 18). An additional tab with the name of the selected table will be 

added at the left at the top in the Download Wizard.  

Open the Customer tab by clicking it. Instead of a list of tables (Add tab), you will now see a list with fields 

from the Customer table. 
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You can add fields to the download definition by selecting a field at the left and clicking the > button.  

Tip: Double-click 

Double-clicking on desired fields will transfer them to the right side of the screen (and thus add them to the 

download definition). 

 

After adding the No., Name, Address and City fields, the screen will look as follows: 

 

 
 

Now click <OK>, which will create the download definition below (but not execute it yet!).  
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Cell B2 will display the download definition name. 

Cell C3 will display the administration (connection) from which data are retrieved. 

Below, cell C4 will display the table number, and cells C6 to C9 the field numbers. 

Note: Table and field numbers 

Table and field numbers may not be deleted, as they constitute the basis of operation of Exsion Reporting BC. 

Deleting these numbers will negatively affect the download, or may even cause it to malfunction. 

 

After creating the download definition, it must also be executed. This can be done by clicking the <Refresh 

data> button in the menu bar. 

 

You will first see a screen in which you must specify where to execute the download. 
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Specify the field in which you want to start the output and click <OK>.  

The result in this example is as follows: 

 

 

 

 

 

Filtering Download Output 

In paragraph 3.2 you created a download that generated a complete customer list. In this paragraph, the 

download is expanded with a column in which the Sales (LV) field is retrieved. Subsequently, you will add a 

filter, to ensure that only clients with a balance higher than € 0.00 are listed. 

Open the Exsion Reporting BC tab, with the download definition you made in paragraph 3.2. Select a cell in the 

download definition and click the <Dynamic Download> button. You will then be taken to the Download 

Wizard again.  

Search the Sales (LV) field (use the Search field, see also paragraph 3.2). 
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Double-click the Sales (LV) field to add it to the download definition and click <OK>. 

The download definition will then look as follows: 

 

 

 
 

In column E, the row value for Sales (LV) is: TRUE. If a download is expanded, the HIDE option is automatically 

enabled, as there may be instances in which column data are listed to the right of the download output. 

 

You will now modify the download definition, to ensure visibility of the Sales (LV) column and filtering on the 

value of Sales (LV)  being higher than € 0.00. You do not have to open the Download Wizard again, you can 

directly change this in the worksheet. 

 

 
 

Subsequently, click the <Refresh data> button, which will yield the following result: 
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Flow Filter on Download 

Paragraph 3.3 described how to apply a filter on a download. Dynamics BC also has flow filters that can be 

applied to flow fields.  

 

The Customer table contains one flow filter, i.e. Date filter. The Sales (LV) field is a so-called flow field (i.e. a 

calculated field), to which a flow filter can be applied. A flow filter allows you to influence flow field calculation. 

The calculation is thus performed in Dynamics BC.  

 

You can apply the ‘Date filter’ flow filter to the Sales (LV) field. To do so, you have to reopen the Download 

Wizard. Now locate the Date filter field (at the left of the wizard, in the Customer tab) and add it to the 

download definition. Click <OK> and the next download definition will be shown. 

 

 
 

Because the Date filter field is a flow filter, it is not necessary to set the HIDE property to FALSE, as this field 

does not contain data. You can now insert a date filter to the filter (refer to appendix 1 for filter options). This 

date filter will affect the Sales (LV) flow field. 
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Joining Tables 

 
It can happen, that data of which you want to create a report are stored in several tables. Exsion Reporting BC 

allows you to connect tables to each other (joining). However, this is only possible if a unique key exists that 

links the tables in question (for example, the customer number in the Customer and Accounts Receivable 

tables). 

 

This paragraph explains the principle of joining by means of the Customer and Vendor/Purchaser tables. The 

Client table contains the vendor/purchaser code, but not the complete description, which is listed in the 

Vendor/Purchaser table. 

Open the Download Wizard by selecting a cell in the download definition (which we have modified in 

paragraph 3.3) and clicking the <Dynamics Download> button. Now open the Add tab and locate the 

Vendor/Purchaser table. 

 

 

 
 

Double-click the Vendor/Purchase table to add it to the download definition. Prior to adding the table, a 

connection and suggestion screen will appear. 
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In this case, there is only one option, i.e. a connection between the Vendor field from the Customer table and 

the Code field from the Vendor/Purchaser table. Click <OK> to choose a join type in the Download Wizard. 

Once you have selected a type, the join is completed. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

©HB Software B.V. Exsion Reporting Business Central                                Page 15 of 26 

Note: Join types provides information about, for example:  

 

Inner Join:  

Only lists results that allow for creating a link between both tables. If no Vendor data is entered in the 

Customer table, the Customer in question will not be included in the output, because it is not possible to 

establish a link with the Vendor/Purchaser table. 

 

Left Outer Join:  

Lists all customers, even if no Vendor data is entered. 

 

Inner Top 1:  

See explanation of  Inner Join 

Only lists the first row of the Vendor table.  

Outer Top 1:  

See explanation of  Left Outer Join  

Only lists the first row of the Vendor table. 

 

Method:  

States a specific calculation method, to replace functions of the on-premise version of Exsion Reporting BC.  

 

The method can be used across several linked tables.  
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The download definition will then look as follows:  

 

 

 

Now you can add the Name field from the Vendor/Purchaser table to the download definition. 

 

 

 
 

The Hide option checkboxes of the fields that now have been added to the download will automatically be 

ticked. You can easily change the order of fields by dragging them up or down. Change the field order as you 

desire and make all fields visible, except the Vendor field.. 

 

If you click <OK>, you will see the download definition below:   
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Click <Refresh data> to align the output with this download definition. Below, you can see a part of the 

output. 

 

 

 
 

Microsoft Dynamics 365 Business Central database 

 

Database Structure 

 

 
 

The standard version of Dynamics BC contains over 700 tables. If you want to create high-quality and fast 

reports, some working knowledge of the structure of your own Dynamics BC database is essential. The Exsion 

Reporting BC function helps you to find your way in the database.  

 

When you click the Database structure button in the Exsion Reporting BC tab, you will be taken to the screen 

below:  
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When you click <OK>, Exsion Reporting BC will analyse your database and retrieve its structure. 

You now have a database map, listing all tables, fields, indexes and relationships between tables.  

 

All tables are so-called hyperlinks. When you click on a table name, you will immediately be taken to its 

corresponding worksheets. For example, click the Customer table. You will then see the following worksheet: 

 

In the Customer table tab you will see the name, number, type, length and class of all fields. Some fields are 

incorporated as hyperlinks. In that case, a relationship exists between the field in question and another table in 

Dynamics BC. In the Customer table, a relationship exists between the Country field and the Country/Region 

table. When you click on Land, you will immediately be taken to the Country/Region tab. 
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When your table contains an option field, you can have it displayed by hovering your mouse above the field in 

question. 
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Commonly-Used Tables for Developing Reports 

A significant part of the functionality in Dynamics BC is built around a small number of tables. They are 

included in the overview below. Most reports are based on one or more of these tables. 

 

Table 15 – General Ledger Account 

Contains information about general ledger account entries. 

Table 17 – General Ledger Entry 

Contains information about all financial transactions in the database. 

Table 18 – Customer 

Contains customer information 

Table 21 – Customer Entry 

Contains information about customer-related transactions, such as invoices and payments. 

Table 379 – Detailed Customer Entry 

Contains detailed information about customer-related transactions, such as invoices and payments. 

Table 23 – Vendor 

Contains vendor information. 

Table 25 – Vendor Entry 

Contains information about vendor-related transactions, such as invoices and payments. 

Table 380 – Detailed Vendor Entry 

Contains detailed information about vendor-related transactions, such as invoices and payments. 

Table 27 – Article 

Contains article information. 

Table 32 – Article Entry 

Contains information about all article-related transactions (sales/purchase etc.) in the database. This table does 

not contain any information about values.  

Table 5802 – Value Entry 

Contains information about all value-related transactions in the database.  

All operational data, such as sales orders, purchase orders and production orders are stored within a 

‘header/rule’ relationship. A sales order consists of a sales header table that contains general order 

information. The sales header table is related to one or more sales rules (in the Sales Rules table), that contain 

information about articles, quantities, prices etc. 
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Checking Flow Fields in Dynamics Business Central 
 

There are two ways to figure out how a flow field is calculated. The first method is starting Dynamics BC. Then 

go to a card that includes the flow field in question. 

 

For example, open a customer card: 

 

 

 

 

 

You will see that the Balance (LCY) field is a green hyperlink. When you click it, Dynamics BC will open an 

overview of Customer entries. 

 

 

 

 

 

Clicking an amount will take you to <Detailed customer entries> where additional information is displayed. 
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Note: Underlying table data: 

Click the customer list (keyboard shortcut: CTRL + ALT + F1), if you want to know the name of the  

underlying table.  
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Chapter 3 – Pivot Tables   
 

If pivot tables are used, it is possible to automatically update them by clicking the <Refresh data> button. 

 

Note: To automatically update a pivot table, its name is essential.  

 

Its name always starts with: EXSION_. 

 
Example 

Create a dynamic download for the VALUE ENTRY table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

©HB Software B.V. Exsion Reporting Business Central                                Page 24 of 26 

Click <Refresh data> and place the download on a new tab. 

 

 
 

Open the Insert tab, click the <Pivot table> button and create a pivot table.   
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Click <OK>. 

 

Open the Options tab that is part of the Pivot table tools, click the <Pivot table> button and assign a name 

to the pivot table that starts with EXSION_. 

 

 

 

 

 

 

 

 

 

 



 

©HB Software B.V. Exsion Reporting Business Central                                Page 26 of 26 

Drag the fields to their proper location: 

 

 

 

Finish the pivot table and further define the worksheet layout. Now modify the filters in the Exsion Reporting 

BC download and click <Refresh data>. Exsion Reporting BC will download new data and automatically 

update the pivot table. 

 

 

 

 

  

 

 

 

 

 

  

 

 

  

 

 

 

 

 

 


